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panu Ing. Vı́tu Procházkovi za pomoc s projektem a jeho cenné rady, panu
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Abstrakt

Ćılem práce je popsat problematiku sńımáńı pohybu lidského obličeje, zaměřit
se na využit́ı prostředk̊u sńımáńı a zpracováńı dat a naj́ıt př́ıklady reálných
projekt̊u využ́ıvaj́ıćı technologii pro sńımáńı obličeje. Praktická část se zaměřuje
na celý řetězec produkčńıho postupu od napsáńı scénáře, přes instalaci a ka-
libraci systému sńımáńı pohybu až po samotnou aplikaci dat na 3D model
a výsledný render. Pro dosažeńı lepš́ı kvality výsledné animace byla přizvána
profesionálńı herečka Kamila Janovičová a byl sńımán pohyb jej́ı mimiky. Pro
sńımáńı pohybu byla použita technologie Vicon Cara a software CaraLive.
Výsledná data byla zpracována v softwaru CaraPost od společnosti Vicon.
Pomoćı HDR sńımače se následně vytvořil sken hlavy herečky, který se pak
použil jako reference pro vytvářeńı 3D modelu v blenderu. Na hotovou 3D
hlavu herečky byla aplikována nasńımaná data, provedeno čistěńı a oprava
chyb v animaci, a nakonec byla vytvořena krátká CG animace.

Kĺıčová slova

Charakterová animace, sńımáńı pohybu, MoCap, sken obliceje, čǐstěńı dat
z MoCap, mapováńı MoCap dat na model, Vicon Cara, CaraLive, CaraPost,
sńımáńı pohybu obličeje, blender.
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Abstract

The aim of the work is to study the issue of capturing facial expresions, to focus
on the capturing and post-processing data, to find examples of real projects
using the facial motion capture technologies. The practical part focuses on the
workflow of the entire production process, from script writing, through the
installation and calibration facial motion capture system to the actual data
application to the 3D model and the resulting render. In order to improve
the quality of the resulting animation, professional actress Kamila Janovičová
was invited. Her facial expressions were captured with Vicon Cara technology.
The resulting data was processed with Vicon’s CaraPost software. Then 3D
model of the actress’s head by HDR scan was created . This scan was used as
reference for creating 3D model of the head with clean topology in blender.
Capturing data was applied to the finished head, cleaned and corrected bugs
in the animation, and then a short CG animation was created.

Keywords

Character animation, motion capture, MoCap, facial scan, cleaning captured
data, mapping MoCap data to model, Vicon Cara, CaraLive, CaraPost, facial
motion capture, blender.
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1.12 Př́ıklad umı́stěńı r̊uzných druh̊u marker̊u . . . . . . . . . . . . . . 18
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3.16 Výsledek po použit́ı modifier Shrinkwrap . . . . . . . . . . . . . . 40
3.17 Plochy na které se aplikuje modifier Corective smooth . . . . . . . 40
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3.22 Základ armatury . . . . . . . . . . . . . . . . . . . . . . . . . . . . 44
3.23 Umı́stěńı kosti v centru MoCap bodu . . . . . . . . . . . . . . . . . 44
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Úvod

Zachyceńı pohybu (motion capture, dále také MoCap) je technologíı di-
gitálńıho záznamu pohybu objektu, jehož výsledkem je źıskáńı sady dat, která
se daj́ı dále využ́ıt např́ıklad pro tvorbu 3D animaćı nebo pro analýzu tohoto
pohybu. V současnosti se s touto technologíı lze setkat v r̊uzných oborech,
nejčastěji však v herńım a filmovém pr̊umyslu, dále také v oblasti robotiky,
vojenstv́ı, stroj́ırenstv́ı, sportu či biologie. V České republice se nejv́ıce
využ́ıvá pro lékařské účely. Moderńı technologie umožňuj́ı nahrát pohyb
mnoha lid́ı najednou včetně mimiky jejich obličej̊u, přičemž právě sńımáńı
pohyb̊u obličeje patř́ı k nejnáročněǰśım typ̊um motion capture. Záznam mi-
miky je problematický vzhledem k anatomii lidského obličeje a komplexnosti
jeho pohybu v pr̊uběhu vyjadřováńı emoćı. Současné technologie umožňuj́ıćı
záznam mimiky však stále vyžaduj́ı mnoho manuálńı práce při zpracováńı
źıskaných dat.

V teoretické části práce je definován záznam pohybu, proveden rozbor typ̊u
technologie pro MoCap, učiněna analýza možných nástroj̊u motion capture se
zaměřeńım na lidský obličej a problematiku sńımáńı mimiky a výčet př́ıklad̊u
reálných projekt̊u s využit́ım MoCap zař́ızeńı pro sńımáńı mimiky. Dále práce
popisuje produkčńı řetězec (workflow) pro tvorbu obličejové animace využité
ve studiu Warhorse a postup, který byl navržen pro potřeby tohoto projektu.
Pro dosažeńı lepš́ıch a přirozených výsledku animace bylo provedeno sńımáńı
pohybu profesionálńı herečky Kamily Janovičové. Mimika byla zachycena na
základě navrženého scénáře odpov́ıdaj́ıćıho ćıl̊um práce, který byl inspirován
castingovými zkouškami v plzeňském filmovém studiu.

Praktická část práce se věnuje popisu navrženého workflow a to od
vytvořeńı scénáře až po nastaveńı konečného renderu. Samotné sńımáńı
pohybu obličeje je provedeno v MoCap laboratoři Západočeské univerzity
v Plzni zař́ızeńım Vicon Cara společnosti Vicon, která je jednou z vedoućıch
firem odvětv́ı výroby optických systémů pro sńımáńı pohybu. Technologie
této firmy jsou často využity ve filmových i herńıch studíıch. Záznam herecké
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Úvod

akce byl proveden softwarem CaraLive. Významnou součást́ı produkčńıho
řetězce je postprocessing – čǐstěńı źıskaných dat z Vicon Cara od šumu
a korekćı detekce marker̊u pomoćı softwaru CaraPost. Následně je popsána
aplikace MoCap dat na 3D model vytvořený užit́ım skeneru. Nakonec jsou
popsány možné problémy vyskytuj́ıćı se při aplikováni źıskaných dat i s jejich
možnými řešeńımi. Výsledkem práce je krátká CG animace obličeje s využit́ım
nasńımaných a zpracovaných dat.

Problematika sńımáńı obličeje je aktuálńı, nebot’ se nejedná o proces auto-
matizovaný, ale o proces, který stále vyžaduje mnoho manuálńı práce. Oproti
záznamu pohyb̊u celého těla vyžaduje obličej větš́ı počet použitých marker̊u
a kvalitněǰśı kamery pro zaznamenáńı všech detail̊u. Tato práce posuzuje
využit́ı technologie Vicon Cara a př́ıslušného softwaru.

2



Kapitola 1
Teoretický rozbor záznamu

pohybu

Pojem záznam nebo zachyceńı pohybu vycháźı z anglického Motion Capture,
neboli zkráceně MoCap. Motion capture zahrnuje měřeńı polohy a orientace
objekt̊u ve fyzickém prostoru a následné zaznamenáńı těchto informaćı do
poč́ıtačem zpracovatelné podoby, přičemž objektem zájmu může být jak lidská,
tak jakákoli jiná postava či objekt ve scéně. Figurant, nejčastěji člověk, je tedy
pouze nositelem informace, kterou nám MoCap umožňuje extrahovat, zpra-
covat a následně aplikovat na daľśı objekt, typicky 3D postavu ve virtuálńı
scéně. [1] Tento pojem vycháźı z článku autorky Maureen Furnissové, která se
ve své práci zabývala technickými a estetickými otázkami týkaj́ıćı se techno-
logie záznamu pohybu. [2]

Za předch̊udce záznamu pohybu se považuje rotoskopie – nafilmovaný po-
hyb reálného člověka nebo zv́ı̌rete byl ručně překreslován a mohla tak vznik-
nout filmová sekvence s přirozeným pohybem. [2] Rotoskopii vynalezl Max
Fleischer v roce 1915 a byla využita v animovaných filmech ”Out Of The
Inkwell”, ”Koko the Clown”a ”Fitz”. [3]

Jako prvńı ocenila možnosti záznamu pohybu herńı studia a začala jej
využ́ıvat ve svém odvětv́ı. ”Reikai Doushi“ (1988) a ”Prince of Persia“ (1989)
byly prvńımi pokusy simulovat pohyb technologíı zachyceńı pohybu ve vi-
deohře, i když nepouž́ıvaly skutečnou technologii MoCap. Prvńı hra, která
motion capture využila, je ”Virtua Fighter 2“ a byla vydána v roce 1994.
V dnešńı době je tato technologie stále nejv́ıce využ́ıvána herńımi vývojáři,
přibližně 70 % z celkového využit́ı. [4]

Záznam pohybu ve filmovém pr̊umyslu nebyl ze začátku tak populárńı, a to
kv̊uli odlǐsnému použit́ı źıskaných dat z videoher. Kvalita postav ve videohrách
byla ńızká a źıskaná data nevyžadovala pečlivé čǐstěńı. Dlouhou dobu nemohla
technologie sńımáńı pohybu naj́ıt své využit́ı ani ve filmech [4]. Prvńı film,
který MoCap využ́ıval, byl ”Sinbad: Beyond The Veil Of Mists“ z roku 2000.
[3]
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1. Teoretický rozbor záznamu pohybu

Nejv́ıce se, že nejv́ıce se technologie motion capture š́ı̌rila v zábavńım
pr̊umyslu, ale v současné době je možné se technikou sńımáńı pohybu setkat
třeba i v medićıně, a to např́ıklad v oblasti analýzy ch̊uze, rehabilitace, držeńı
těla, rovnováhy, biomechanického výzkumu a vědy o živočǐsných produktech.
V České republice se sńımáńı pohybu pož́ıvá nejv́ıce právě pro medićınské
účely. [5] Analýza pohybu se také využ́ıvá pro zvýšeńı výkonu sportovc̊u nebo
prevenci úraz̊u, at’ už klinických, výzkumných nebo vzdělávaćıch oborech.
Daľśım zaj́ımavým využit́ım je zoologie, MoCap zde pomáhá při analýze bi-
omechaniky zv́ı̌rat, zkoumáńı chováńı nebo jednoduše zaznamenáńım pozice.
Existuj́ı př́ıklady využit́ı této technologie spoč́ıvaj́ıćı v zaznamenáńı pohybu
i ve virtuálńı realitě. Pomoćı MoCap mohou uživatelé vyzkoušet r̊uzné druhy
scenéríı jako tanec s virtuálńım partnerem.

1.1 Druhy záznamu pohybu

Existuj́ı dvě metody záznamu pohybu, a to markerové a bezmarkerové
systémy. Markery jsou speciálńı kuličky, které jsou na herce po dobu záznamu
umı́stěny. Bezmarkerové systémy na druhou stranu nahrávaj́ı herce bez
speciálńıch znak̊u.

1.1.1 Markerové systémy

Markerové systémy se děĺı na akustické, mechanické, magnetické a optické.

1.1.1.1 Akustické systémy

Akustický systém nab́ıźı systém zvukových vyśılač̊u, které jsou umı́stěny na
kloubech herce, zat́ımco tři čidla jsou umı́stěna v mı́stě zachyceńı (capture
suite). Emitory pak postupně aktivuj́ı produkuj́ıćı sadu frekvenćı, jež receptory
následně zachyt́ı, a poté použij́ı pro výpočet pozic v trojrozměrném prostoru.
Aparatura akustického sńımáńı pohybu použ́ıvá přenos vysokofrekvenčńıho
zvuku, který bývá vyśılán na základě zdrojových složek. Zvuk je přij́ımán
mikrofony. V rámci akustického sńımáńı rozlǐsujeme dvě metody – inside-out,
(zdroj zvuku je na monitorovaném objektu a mikrofony jsou rozmı́stěné po
prostoru) a outside-in, (zdroj zvuku je přij́ımán z okoĺı s mikrofony na těle
herce). [6]

1.1.1.2 Mechanické systémy

Mechanické systémy jsou vyrobeny z potenciometr̊u a jezdc̊u, které jsou
umı́stěné na požadovaných kloubech a umožňuj́ı zobrazeńı jejich polohy.
I když systémy mechanického sńımáńı pohybu nejsou dostatečně rozvinuté,
také maj́ı určité výhody. Jednou z výhod těchto systémů je rozhrańı, které
umožňuje snadný přechod mezi r̊uznými technologiemi. Konečná výhoda
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1.1. Druhy záznamu pohybu

spoč́ıvá v tom, že nejsou ovlivněny magnetickými poli nebo nežádoućımi
odrazy, v jejich př́ıpadě neńı zapotřeb́ı dlouhého procesu rekalibrace, což
práci usnadňuje a čińı ji i produktivněǰśı. [7]

Obrázek 1.1: Mechanický systém záznamu pohybu

Zdroj: [7]

1.1.1.3 Magnetické systémy

Magnetické systémy využ́ıvaj́ı sad receptor̊u, které jsou umı́stěny na klou-
bech herce, a je možné měřit umı́stěńı a orientaci kloub̊u v̊uči anténě. Magne-
tické systémy nejsou ve srovnáńı s jinými systémy pro zachyceńı pohybu př́ılǐs
drahé. Pracovńı stanice, která se použ́ıvá pro sběr a zpracováńı dat, je také
levná a přesnost dat je poměrně vysoká. S typickou vzorkovaćı rychlost́ı 100
sńımk̊u za sekundu jsou magnetické systémy ideálńı pro jednoduché zachyceńı
pohybu. Nevýhody těchto systémů zahrnuj́ı obrovské množstv́ı kabel̊u, které
se připojuj́ı k anténě, což snižuje stupně volnosti herce. [7]

1.1.1.4 Optické systémy

Při využit́ı optických systému nośı herec speciálńı oblek pokrytý reflektory,
které jsou umı́stěny v jeho hlavńıch kloubech. Kamery s vysokým rozlǐseńım
jsou strategicky umı́stěny tak, aby sledovaly tyto reflektory během pohybu
herce. Každá kamera generuje 2D souřadnice každého reflektoru, źıskaného
stupněm segmentace. Vlastńı software se pak použ́ıvá k analýze dat zachy-
cených všemi kamerami pro výpočet 3D souřadnic reflektor̊u. Tyto systémy
jsou nejdražš́ımi na trhu kv̊uli jejich složité technologické povaze, jako jsou
kamery s vysokým rozlǐseńım a sofistikovaný software.
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1. Teoretický rozbor záznamu pohybu

Obrázek 1.2: Magnetický systém záznamu pohybu

Zdroj: [8]

Obrázek 1.3: Optický systém záznamu pohybu

Zdroj: [8]
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1.2. Technologický postup sńımáńı pohybu

Výhodou použit́ı těchto systémů je předevš́ım velmi vysoká vzorkovaćı
frekvence, která umožňuje zachytit rychlé pohyby, jako jsou např́ıklad bojová
uměńı, akrobacie a gymnastika. Daľśı výhodou je svoboda nab́ızená těmito
systémy, protože na rozd́ıl od ostatńıch systémů nevyžaduj́ı použit́ı kabel̊u
a použit́ı reflektor̊u neomezuje nijak pracovńı prostor. [7]

1.1.2 Bezmarkerové systémy

Neustále se rozšǐruj́ıćı výzkum v oblasti poč́ıtačové grafiky umožňuje rychlý
vývoj technik detekce bezmarkerového optického pohybu. Tyto systémy
nevyžaduj́ı speciálńı vybaveńı pro sńımáńı pohybu herc̊u. Pohyb herc̊u se
zaznamenává ve v́ıce video-toćıch a algoritmy poč́ıtačového viděńı analyzuj́ı
tyto proudy pro identifikaci lid́ı. Proces zachyceńı pohybu je proveden
jenom prostřednictv́ım softwaru. Dokonalým př́ıkladem takového systému
je Microsoft KINECT, který úspěšně zavedl řešeńı pro zachycováńı pohyb̊u
s ńızkými náklady. [7]

1.2 Technologický postup sńımáńı pohybu

Źıskańı MoCap dat a jejich samotná aplikace na 3D model se skládá
z několika krok̊u, tzv. produkčńıho řetězce neboli workflow. Postup se muže
lǐsit v závislosti na projektu a konkrétńım hardwaru nebo softwaru. Každé
MoCap studio, at’ už filmové nebo herńı, má vlastńı produkčńı řetězec, který
se poč́ıtá jako know-how. Obecný postup se skládá z několika krok̊u:

1. Analýza ćıl̊u a výběr vhodného systému nebo kombinace systémů.

2. Rozvržeńı a sestaveńı hardware systému.

3. Nastaveńı software systému.

4. Zamaskováńı rušivých element̊u (světel, protilehlých kamer, reflexivńıch
předmět̊u).

5. Kalibrace systému (rozměry, kontrast, jas).

6. Záznam základńı pozice (u člověka T-pozice).

7. Dokumentace polohy marker̊u.

8. Identifikace marker̊u v softwaru a jejich vhodné pojmenováńı.

9. Záznam pohybu.

10. Návrat do základńı pozice (doporučeno).

11. Kontrola dat.
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1. Teoretický rozbor záznamu pohybu

12. Uložeńı nezpracovaného záznamu.

13. Vyčǐstěńı dat (odstraněńı šumů a špatně identifikovaných marker̊u).

14. Uložeńı záznamu ve vhodném formátu.

15. Import pohybu do mapovaćıho softwaru.

16. Namapováńı pohybových dat na virtuálńıho figuranta (herce).

17. Propojeńı herce s ćılovou postavou (charakterizace).

18. Aplikace pohybu s ćılovou postavou.

19. Export výsledné postavy i s pohybem a daľśı použit́ı. [1]

1.3 Datové formáty záznamu pohybu

Existuj́ı dva hlavńı typy dat záznamu pohybu: data o translaci a data rotace.
Translačńı data generuj́ı optické systémy, rotačńı vytvář́ı mechanické systémy,
magnetické systémy umı́ oba dva typy. Translačńı data jsou užitečná pro ani-
maci obličeje a aplikaci v reálném čase. Rotačńı data jsou užitečná pro animaci
celého těla s kostrou.

Formáty C3D, ASF / AMC, BVH a FBX jsou nejčastěji použ́ıvané pro
sńımáńı pohybu. C3D, ASF / AMC a BVH jsou formáty vyvinuté speciálně
pro zachyceńı pohybu, zat́ımco FBX je určen pro 3D animaci obecně. Formáty
ASF / AMC a BVH uchovávaj́ı hierarchické údaje skeletu, zat́ımco formát
C3D ne. [9] Vı́ce informaćı s podrobným popisem je možné naj́ıt v knize

”Understanding Motion Capture for Computer Animation“. [10]
V praktické části práce se použ́ıvá formát C3D kv̊uli vybranému 3D edi-

toru blender, který pracuje lépe s t́ımto formátem (umožňuje automatické
generováńı kosti z MoCap bodu, což je velkou výhodou při aplikaci dat).

1.4 Specifika záznamu obličeje

V dnešńı době se potkáváme s r̊uznými druhy zachycováńı pohybu: sńımáńı
těla, obličeje nebo rukou. Každý druh motion capture má své specifikace.
Sńımáńı obličeje nebo rukou je mnohem komplikovaněǰśı než záznam těla a to
nejenom kv̊uli malému rozměru objektu, ale také kv̊uli anatomické složitosti
lidského obličeje a rukou. Záznam prst̊u rukou je zat́ım sṕı̌se neřešitelným
problémem, protože datové rukavice, které pohyb nahrávaj́ı, nejsou dostatečně
přesné. Sńımáńı pohybu obličeje se použ́ıvá v dnešńı době docela často, ale
stále má jisté problémy a zat́ım neexistuje jednoduchý a levný zp̊usob, který
by měl perfektńı výsledky. Aktuálńı problémy a složitost záznamu pohybu
obličeje představovaly jistou motivaci při výběru tématu bakalářské práce.
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Existuje několik mechanických a optických zař́ızeńı pro zachyceńı pohybu
obličeje. Nejčastěji použ́ıvané jsou optické obličejové sledovače v reálném čase.
Konstrukce se skládá z kamery, která je umı́stěna tak, aby se pohybovala
s hercem. Zař́ızeńı zachycuje pohyb malých značek umı́stěných na obličeji
sledovaného figuranta. Jsou to 2D zař́ızeńı, která nemohou zachytit určité
pohyby, jako je např́ıklad zvrásněńı rt̊u, takže data nejsou př́ılǐs realistická.
Trojrozměrné údaje o pohybu obličeje lze zachytit pomoćı optického systému,
který má alespoň dvě nebo v́ıce kamer, což dává mnohem lepš́ı výsledek, ale
ne v reálném čase.

Existuj́ı také nověǰśı optické systémy, které nevyžaduj́ı značky, ale jsou
založeny na analýze optických tok̊u. Takový systém byl použit pro zachyceńı
obličej̊u ve filmu Avatar. Princip zachyceńı obličeje je založen na kombinaci
optických zachyceńı a softwarových algoritmů. [10]

1.4.1 Anatomie obličeje

Tvář je jedinou část́ı lidského těla, kde se některé volné svaly připojuj́ı k jiným
sval̊um mı́sto kost́ı. Většina obličejových sval̊u je malá, tenká, vrstevnatá a za-
budovaná do tukové tkáně. Lidská lebka se skládá z 8 kraniálńıch kost́ı a 14
obličejových kost́ı a jej́ı tvar je základem vzhledu jedince. Celkem 22 kost́ı
lebky tvoř́ı v́ıce dutin: největš́ı, kde se nacháźı mozek a menš́ı, které slouž́ı
k usazeńı oč́ı, uš́ı, nosu a úst.

Kv̊uli anatomické složitosti lidského obleče je doporučeno pro vytvářeńı
animace a záznamu pohybu obličej̊u použ́ıvat anatomická skripta. Práci může
usnadnit tvorba značkovaćı sady marker̊u a rig̊u. Kromě anatomie jsou dosti
d̊uležité i morfologie a morfogeneze obličeje. Vědět, jak všechny r̊uzné kosti
a svalové systémy spolupracuj́ı, pomůže vytvořit lepš́ı výsledky. [9]

1.4.2 Vytvářeni rig̊u pro obličej

Ve stadiu aplikace záznamových dat na 3D model tvoř́ı d̊uležitou část práce
vytvářeni rig̊u a kost́ı. Vytvářeńı rig̊u je proces vytvořeńı řady ovládaćıch
prvk̊u (”rig“) k deformaci jiného objektu. Zahrnuje vytvářeńı speciálńıch ob-
jekt̊u, které přesouvaj́ı vybrané skupiny vrchol̊u najednou. Toto je princip ske-
letové animace (armature), kde se objekty nazvané ”kosti“ použ́ıvaj́ı k ovládáńı
část́ı model̊u. [4]

Existuj́ı následuj́ıćı metody vytvářeńı rigu:

• obličejový rig pomoćı diskrétńıch kost́ı
Představuje nejjednodušš́ı zp̊usob, spoč́ıvá v připevněńı marker̊u ke sku-
pině kloub̊u, které jsou spojeny s geometríı k̊uže obličeje. Nejprve je
potřeba vytvořit sad̊u diskrétńıch kost́ı, které nemaj́ı hierarchické vztahy
k sobě navzájem (zat́ımco kosti v kostře jsou obvykle v hierarchii).
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Umı́stěńı kosti na 3D model obličeje by mělo odpov́ıdat umı́stěńı mar-
ker̊u na objektu při motion capture. Dále sleduje spojeńı geometrie k̊uže
s kost́ı. Nakonec je potřeba omezit vzdálenosti vlivu každé kosti.

• obličejový rig pomoćı svalu
Daľśım př́ıstupem je vytvořeńı ”sval̊u”, které jsou umı́stěny pod k̊už́ı
obličeje kolem úst a oč́ı a na tvář́ıch, čele, bradě a daľśıch částech obličeje,
které je potřeba oživit pomoćı MoCapových dat. Svaly se použ́ıvaj́ı jako
objekty ovlivňuj́ıćı okoĺı. Obrázek 1.4 ukazuje geometrii k̊uže a ”svalové“
polygony pro k̊uže.

• obličejový rig pomoćı inverzńı kinematiky

Obrázek 1.4: Geometrie k̊uže a ”svalové“ polygony pro k̊uži

Zdroj: [9]

Pokud 3D animačńı aplikace umožňuje kombinovat inverzńı kinematiku
(IK) a Forward Kinematics (FK), je možné je využ́ıt při utvářeńı rigu
obličeje. V př́ıpadě animace celého těla (nebo části těla) jsou údaje
o rotačńım MoCapu aplikované na kostru v podstatě animaćı FK. Je
možné je změnit (např. přemı́stit končetinu) pomoćı IK. Smı́cháńım FK
a IK se dá bez problémů spojit i animačńı segment ř́ızený MoCapem
a segment animace s kĺıčovými sńımky. [9]

1.4.3 Hardware a software pro sńımáńı pohyb̊u obličeje

V současné době existuje několik r̊uzných nástroj̊u pro sńımáńı obličeje.
Společnosti Vicon, FaceWare a daľśı navrhuj́ı svoje řešeńı, nejčastěji to jsou
kamerové a senzorické systémy, která s r̊uznou mı́rou přesnosti zachycuj́ı
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lidské tváře v pohybu. Většina firem má sv̊uj vlastńı software, který umožňuje
zpracováńı a čǐstěńı nasńımaných dat. Mezi nejpopulárněǰśı patř́ı:

1. FaceWare
Faceware nab́ıźı produkty pro automatické sledováńı, analýzu a opětovné
zachyceńı 2D pohybu na 3D ploše. Hlavńı výhodou je možnost vźıt
jakékoliv video a automaticky sledovat pohyb obličeje bez jakéhokoli
vstupu uživatele. Sestavy ProHD Headcam (helma) jsou robustńı kame-
rová řešeńı namontovaná na hlavě použ́ıvaná pro zachyceńı obličeje. Po
proceduře čǐstěńı dat v softwaru Faceware’s Analyzer je možné provést
automatické přepoč́ıtáńı proporćı — obecně se hlava herce proporčně lǐśı
od celého 3D modelu a je potřeba provést korekci, ta se většinou dělá
ručně.

Obrázek 1.5: Helma ProHD Headcam system od FaceWare

Zdroj: [11]

Př́ıklady projekt̊u, ve kterých byla animace obličeje vytvářena pomoćı
zař́ızeńı FaceWare:

• The Witcher 3: Wild Hunt (hra)
• Harry Potter and Goblet of Fire (hra)
• Assassin’s Creed: Syndicate (hra) [12]

2. Vicon Cara
Vicon Cara vycháźı z dlouhé historie společnosti Vicon, která poskytuje
optické systémy založené na markerech pro zachycováńı pohybu těla
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vlastńımi kamerami. Společnost v současnosti nab́ıźı helmu - HeadRig
se čtyřmi kamerami pro stereo zachyceńı marker̊u na obličeji. Kamery
sed́ı na podpěře, která vyčńıvá několik centimetr̊u od obličeje, dvě na
obou stranách. Pro záznam a odezvu v reálném čase nab́ıźı společnost
Vicon software CaraLive, pro daľśı zpracováńı a čǐstěńı dat pak software
CaraPost. [13]

Obrázek 1.6: Cara od Vicon

Zdroj: [14]

Př́ıklady projekt̊u, ve kterých byla animace obličeje vytvořena pomoćı
zař́ızeńı Vicon Cara:

• Transformers (film)
• Iron man (film)
• The Avengers (film)
• Pirates of the Caribbean (film)
• Rango (animovaný film) (hra) [15]

3. Dynamixyz
Společnost Dynamixyz má k dispozici helmu HMC (head mounted
camera system), která má snadné nastaveńı a je rychle připravena
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ke sńımáńı. Zaznamenává až 120 sńımk̊u za sekundu pro zachyceńı
rychlých pohyb̊u rt̊u a mrkáńı, a to i u nejmenš́ıch, nejrychleǰśıch
pohyb̊u, je kompatibilńı se všemi systémy zaměřeńı těla. Pro čǐstěńı
využ́ıvá tato společnost software Performer, který vyžaduje trénink.
Jakmile je systém naučen, sledováńı a změna proporćı obličeje se stávaj́ı
zcela automatickými a systém dodává skvělé surové animace, které
většinou nevyžaduj́ı žádné daľśı čǐstěńı. Dynamixyz se ukázal jako jeden
z nejstabilněǰśıch bezmarkerovych trackovaćıch systémů na světě. [16]

Obrázek 1.7: Head-mounted camera system (helma) od Dynamixyz

Zdroj: [16]

Př́ıklady projekt̊u, ve kterých byla animace obličeje vytvářena pomoćı
tohoto zař́ızeńı:

• Death Note (film)
• Resident Evil 7 (hra)
• Horizon: Zero Dawn (hra)
• Conan Exiles (hra) [17]

4. CUBIC MOTION
Společnost se zabývá jen poč́ıtačovým viděńım (v angličtině computer
vision). Primárńımi zákazńıky společnosti jsou herńı vývojáři. CUBIC
MOTION nab́ıźı software cmLive pro světově nejpřesněǰśı sńımáńı
pohyb̊u obličeje v reálném čase. Technologie poč́ıtačového viděńı
umožňuje vysoce kvalitńı obličejové animace živých postav, cmStudio
je produkčńım nástrojem pro MoCap studio, cmEngine je modelová
platforma pro vize, má bezkonkurenčńı schopnost sledovat v reálném
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1. Teoretický rozbor záznamu pohybu

čase údaje bez marker̊u od mnoha r̊uzných sńımač̊u. Výhodou je
možnost sledováńı oč́ı, a to mrknut́ı, samotný pohyb a rozš́ı̌reńı zornic.
Př́ıklady projekt̊u, ve kterých byla animace obličeje vytvářena pomoćı
tohoto zař́ızeńı:

• Hellblade: Senua’s Sacrifice (hra)
• Spiderman (hra)
• Horizon: Zero Dawn (hra)
• COD: WWII (hra) [18]

1.5 Vicon Cara

Pro účely této práce bylo vybráno zař́ızeńı Vicon Cara z d̊uvodu jeho dostup-
nosti. Dı́ky spolupráci se Západočeskou univerzitou nám byl umožněn př́ıstup
do jejich MoCap laboratoř́ı.

Společnost Vicon má třicetileté zkušenosti ve výrobě optických systému
pro sńımáńı pohybu a je jednou z vedoućıch firem v tomto odvětv́ı. V roce 2014
na konferenci SIGGRAPH představila společnost inovačńı systém Cara – tech-
nologii pro sńımáńı obličeje. [19]

Prototyp Cary vznikl během spolupráce společnosti Vicon s ImageMovers
Digital na animovaném filmu ”Vánočńı koleda“. Předch̊udce měl nižš́ı rozlǐseńı
a nižš́ı frekvenci sńımk̊u, přesto byl schopen zachytit nekonečný zápal herce
Jima Carreyho. Proto se Vicon zaměřila na vývoj produktu, který by vyho-
voval širš́ı potřebě. Po pěti letech představili Caru, jakožto nejkomplexněǰśı
produkt, který společnost vyrobila. [20]

Nejd̊uležitěǰśı vlastnosti Cary jsou kvalita, flexibilita a komfortńı využit́ı.
Čtyři kamery s vysokým rozlǐseńım, které synchronně zachycuj́ı veškeré
informace, a jednoduše konfigurovatelné světlo zajǐst’uj́ı, že budou zachyceny
veškeré podrobnosti pohybu. Produkt byl navržen jako modulárńı systém,
který umožňuje uživateli konfiguraci podle jeho potřeb. Uživatel nemuśı
využ́ıvat pro post-processing produkty od Viconu, Cara umožňuje pracovat
s výrobky jiných společnost́ı. Každá součást systému byla navržena tak, aby
zajǐst’ovala herci svobodu projevu a pohybu. [13]

Systém Cara pro sńımáńı obličeje se skládá z hardwarové části, kam patř́ı
HeadRig, 4 kamery, logger a ostatńı př́ıslušenstv́ı, a softwarové, produkty Ca-
raLive a CaraPost.

1.5.1 Hardware Vicon Cara

Samotný hardware Vicon Cara je vlastně speciálńı náhlavńı souprava - Head-
Rig, která na sobě má čtyři konfigurovatelné kamery s vysokým dynamickým
rozsahem (volitelně IR), váž́ı 1,2 kg. HeadRig je jednou z největš́ıch inovaćı
systému Cara. [19]

14



1.5. Vicon Cara

Obrázek 1.8: HeadRig pohled shora

Zdroj: [14]

Čtyři kamery v systému Cara jsou HD s rozlǐseńım 720p a až 60 sńımk̊u
za sekundu a 3mm lens F2.0 IR filtrem. Váž́ı 31g a jsou dostatečně lehké na
to, aby byly umı́stěny na HeadRig a nejsou překážkou pro herecký výkon. [14]

Obrázek 1.9: Kamera

Zdroj: [14]

Dále patři mezi komponenty Cara Logger (záznamńık). Je to malá jed-
notka, která ukládá synchronizované sńımky až ze čtyř kamer Cara a umožňuje
streamovat živé náhledy kamer prostřednictv́ım bezdrátového připojeńı. Má
vysokou kvalitu komprese, integrovaný přij́ımač časového kódu a záznamový
čas přibližně 120 minut v závislosti na použité frekvenci sńımk̊u. LED dioda
záznamńıku poskytuje zpětnou vazbu na stav systému.
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1. Teoretický rozbor záznamu pohybu

Obrázek 1.10: Logger

Zdroj: [14]

Daľśı součást́ı systému je Light Kit - světelná soustava navržená tak,
aby obklopovala kameru a nepřekážela při sńımáńı. Každé světlo je složeno
z 9 LED diod, které jsou rozestavěny do mezikruž́ı výseče. Všechna čtyři světla
vytvář́ı plošné světlo umožňuj́ıćı pracovat v prostřed́ı s nedostatečným nebo
měńıćım se okolńım osvětleńım. [14]

Obrázek 1.11: LightKit

Zdroj: [14]

”Systém prakticky tvoř́ı inerciálńı soustavu hlavy v̊uči tělu. Pro identifikaci
v rámci sńımáńı celého těla je na čelence prostor pro umı́stěńı speciálńıch tzv.
kódovaných marker̊u, které ve scéně identifikuj́ı jednotlivé herce (jejich hlavy),
ale slouž́ı i k jednoznačné referenci počátku souřadnicové soustavy hlavy.“ [19]

1.5.2 Software Vicon Cara

Společnost Vicon navrhuje k použit́ı vlastńı software pro sńımáńı a zpracováńı
dat, což neńı ale nutné, Cara umožňuje pracovat i s aplikacemi třet́ıch stran.
Systém Cara využ́ıvá dva kusy softwaru: CaraLive, CaraPost.

Software CaraLive je jádrem systému Cara během instalace a sńımáńı. Ca-
raLive umožňuje uživateli kontrolovat, spravovat a monitorovat systém a na-
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1.5. Vicon Cara

Tabulka 1.1: Doporučené parametry poč́ıtačové sestavy výrobcem pro práci
se systémem CaraLive. Zdroj:[14]

Hardware Doporučeno Viconem

Procesor Quad core 3+GHz processor
Pamět’ 4 GB
Pevný disk 500 GB
Grafická karta NVidia Quadro 2000 nebo jiné ekvivalentńı grafické karty
Operačńı systém Windows 7 Professional 64-bit
Śıt’ová karta Dvouportová
Wi-Fi router(se switchem) ASUS RT-N66U(Dark Knight).

staveńı a zachycovat procesy. Bezdrátový přenos zajǐst’uje neustálé sledováńı
zaznamenávaných sńımk̊u. Barevná zpětná vazba stavu systému společně se
systémovými upozorněńımi poskytuje nepřetržité informace o jeho stavu, což
umožňuje přijmout př́ıpadná opatřeńı. [14]

Software CaraPost poskytuje převody a nástroje pro extrakci vysoce kva-
litńıch dat, 3D bod̊u z marker̊u, na základě nasńımaných záběr̊u CaraLive.
Pomoćı kamerových obraz̊u a kalibrace vytvořené pomoćı CaraLive, CaraPost
automaticky identifikuje body a sleduje je v pr̊uběhu času. Poté vytvoř́ı body
reprezentuj́ıćı 3D markery z obličeje herce. Výsledná data jsou připravena pro
export do softwar̊u třet́ıch stran. [14]

Tabulka 1.2: Doporučené parametry poč́ıtačové sestavy výrobcem pro práci
se systémem CaraPost. Zdroj: [14]

Hardware Doporučeno Viconem

Procesor Quad core 3+GHz processor
Pamět’ 16 GB
Pevný disk 500 GB
Grafická karta NVidia Quadro K4000 nebo ekvivalentńı grafická karta
Operačńı systém Windows 7 Professional 64-bit

1.5.3 Markery

Vicon Cara nevyžaduje speciálńı sadu marker̊u a umožňuje pracovat s r̊uznými
druhy marker̊u. Současný výzkum Vicon ukazuje, že můžeme źıskat dobré
výsledky ze směsi b́ılých a reflexńıch hemisférických marker̊u a plochých kru-
hových samolepek. Tyto reflexńı značky vykazuj́ı dobré výsledky při použit́ı
př́ıdavného světla, ale nefunguj́ı v exteriéru a to i při použit́ı světla. B́ılé značky
funguj́ı dobře při natáčeńı venku.

Následuj́ıćı př́ıklad ukazuje umı́stěńı značek hemisféry na rtech a čelisti,
očńıch v́ıčkách a ploché samolepky na zbytku obličeje.
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1. Teoretický rozbor záznamu pohybu

Tabulka 1.3: Porovnáńı marker̊u

Zdroj: [14]
Typ marker̊u Plusy Minusy

Samolepky

Snadněǰśı použit́ı a odstraněńı,
snadněǰśı źıskáńı správného tvaru
kruhu sledováno lépe ve st́ınu,
může být velmi malý (např. 2 mm).

Pot může zp̊usobit jejich
odpadnut́ı docela rychle.
Při živém sńımáńı může
spadnout a následně být
nalepen na špatnou pozici.

Polokoule (hemisféra) Nezakryje se, funguje na okraji obličeje. Snadno se ztrat́ı.

Malované (pomoćı pera)

Pohybuje se s k̊už́ı, rychle se aplikuje,
méně pravděpodobně bude náhodně
odstraněn, méně lesklý než
MoCapový inkoust.

Může se rozmazat nebo
deformovat. Snadno se ztrat́ı,
nefunguje na okraji obličeje,
kde se jev́ı jako rovina.

Malované (pomoćı inkoustu MoCap) Jako pero (výše), ale černěǰśı
a jednodušš́ı odstraněńı.

Leskne se v́ıc (a proto těžš́ı
sledovat) než pero.

Obrázek 1.12: Př́ıklad umı́stěńı r̊uzných druh̊u marker̊u

Vicon doporučuje využ́ıvat speciálńı stabilizačńı značky umı́stěné nahoře
na hlavě nebo v bĺızkosti uš́ı. Důležité je ujistit se, že jsou alespoň viditelné
pro dvě kamery. I když je zde možné použ́ıt ploché značky, doporučuj́ı se
6mm kruhové značky umı́stěné na podstavćıch. Tento typ značky může být
umı́stěn kolem spánk̊u a uš́ı, kde je pohyb nejdrobněǰśı, což je d̊uležité pro
dobré stabilizačńı výsledky. Jiná vhodná mı́sta pro stabilizaci marker̊u jsou
pod nosem a kolem mostu nosu. Jak ukazuje praxe, naj́ıt na lidském obličeji
pevný bod neńı jednoduché, protože se k̊uže při r̊uzných mimických výrazech
deformuje prakticky všude.

V tabulce 1.3 uvedeno porovnáńı r̊uzných druh̊u marker̊u při sńımáńı Mo-
Cap dat pomoćı Cary.
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Kapitola 2
Princip a postup sńımáńı

obličeje

Produkčńı řetězec neboli workflow pro sńımáńı obličeje s následným zpra-
cováńım a aplikaćı dat na 3D model se lǐśı u každého studia zabývaj́ıćıho se
motion capture. Obličejová animace pomoćı MoCap je komplikovaná a zat́ım
neexistuje automatické řešeńı tohoto problému. Každý proces sńımáńı a apli-
kováńı MoCap dat stále vyžaduje ručńı práci. Přibližný poměr práce odpov́ıdá
jednomu dni sńımáńı MoCap dat a třem dn̊um jejich čǐstěńı a opravy. Každé
studio či firma použ́ıvá sv̊uj vlastńı produkčńı řetězec, jenž bývá zpravidla
chráněným tajemstv́ım (know-how). V této kapitole jsou popsány zjǐstěné
možné zp̊usoby vytvářeńı obličejové animace: workflow studia Warhorse
využitý při tvorbě hry Kingdom Come: Deliverance a workflow navržený pro
potřeby této závěrečné práce.

2.1 Sńımáńı pohybu obličeje dle studia Warhorse

Studio Warhorse je mladé vývojářské studio zabývaj́ıćı se tvorbou
poč́ıtačových her. Ačkoliv bylo studio založeno teprve nedávno (rok
2011), skládá se z veterán̊u českého herńıho pr̊umyslu a stoj́ı za takovými
tituly, jako jsou Mafia, Mafia II, Operace Flashpoint, Fish Fillets, Original
War a mnoho daľśıch. Samotné studio má na svém účtu vývoj pouze jed-
noho titulu, Kingdom Come: Deliverance (KC:D), známý nejenom v České
republice, převážně pro obrovský úspěch kickstarterové kampaně a dobrý
marketing. Jeho vývoj stál stovky milion̊u korun a jde tak o nejnákladněǰśı
hru, která v Česku vznikla. [21]

0Kickstarter je internetová platforma podporuj́ıćı kreativńı projekty z r̊uzných oblast́ı.
Využ́ıvá crowdfundingové financováńı, tedy financováńı, při kterém přispěje větš́ı počet jed-
notlivc̊u menš́ım obnosem peněz.
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2. Princip a postup sńımáńı obličeje

V rámci bakalářské práce byla sjednána sch̊uzka s panem Jǐŕım Bartoňkem.
Ten se ve Warhorse studiu stará o vytvářeńı 3D postav, čemuž se věnuje již
od roku 1999. Sch̊uzka se týkala tvorby hry KC:D, zejména zř́ızeńı MoCap
zař́ızeńı pro potřeby projektu, zp̊usob vytvářeńı postav a jejich animaćı na
světové úrovni.

Pro vývoj tohoto projektu si studio muselo poř́ıdit vlastńı MoCap zař́ızeńı,
jinak by se tak náročná a rozsáhlá hra nedala zvládnout v rozumném časovém
úseku. Bylo zakoupeno zař́ızeńı firmy OptiTrack a bylo využito výhradně pro
sńımáńı pohybu celého těla, nikoliv obličeje. Technologie sńımáńı obličeje se
údajně ukázala být př́ılǐs náročná jak časově, tak finančně, a výsledek neńı
dostatečně kvalitńı.

Obrázek 2.1: Studio pro skenováńı

Zdroj: [21]

Firma musela vymyslet sv̊uj vlastńı zp̊usob tvorby animace a zvolit si, jaký
hardware a software pro tyto účely použ́ıt. Pro vytvářeńı animace mluveńı
byl využit software FaceFX, který umožňuje generováńı realistického pohybu
rt̊u na základě audio souboru. Program umožňuje např́ıklad snadné dávkové
zpracováńı tiśıc̊u zvukových soubor̊u a přidáńı emoce do vybrané animace
bez narušeńı synchronizace rt̊u. Samotný software však nijak neumožňuje vy-
jadřováńı emoćı, je tedy třeba je přidat pro dosažeńı realistické a přirozené
animace. [22]

Nejlepš́ım zp̊usobem jak animovat emoce a r̊uzné mimické exprese je
podle názoru studia blend shape animace. Aby 3D modely ve hře vypadaly
realisticky, každá postava měla vlastńı prototyp - herce. Pro potřeby naske-
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2.1. Sńımáńı pohybu obličeje dle studia Warhorse

nováńı obličeje všech herc̊u bylo nutné zř́ıdit vlastńı studo pro skenováńı.2.1
Vytvořené foto bylo využito pro tvorbu 3D modelu fotogrammetrickým
zp̊usobem. Každý herec byl naskenován 24krát, jeden sken byl neutrálńı,
s relaxovaným výrazem, ostatńı zobrazovaly nějaké emoce. Dál se postupovalo
tak, že pomoćı softwaru R3DS WRAP 3.3 low poly byl model s neutrálńım
výrazem přetvářen do podoby skenu, včetně textury. [23]

Obrázek 2.2: Př́ıklad výstupu programu R3DS WRAP 3.3

Zdroj: [23]

Takto se postupovalo s každým skenem. Software umožňoval vytvářet
bland-shapes - postupný přechod od jednoho výrazu k druhému, přitom
se měńı nejenom geometrie, ale také se postupně promı́chává textura. Vy-
tvořeńım rig̊u a provedeńım doplňuj́ıćıch funkćı lze z 24 sken̊u jednoho obličeje
dosáhnout až 60 r̊uzných emoćı. Také se předpokládá ručńı čǐstěńı některých
výraz̊u, obzvláště těch extrémńıch jako křik. Kvalita takové animace je velice
vysoká, ale dost náročná na čas. Proto byl tento zp̊usob práce použit jenom
pro vytvářeńı hlavńı postavy hry. Ostatńı charaktery dostaly ten samý rig. Sa-
mozřejmě bylo potřeba tento rig transformovat tak, aby seděl v̊uči proporćım
ostatńıch hlav. Taková transformace neńı jednoduchá a občas bylo potřeba
čistit chybná mı́sta v animaci ručně.
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2. Princip a postup sńımáńı obličeje

Obrázek 2.3: Př́ıklad rigu na postavě ze hry Kingdom come: Deliverance

Zdroj: [24]

Celkově je studio Warhorse toho názoru, že MoCap technologie zaměřené
na sńımáńı obličeje, se daj́ı použ́ıvat, ale maj́ı se aplikovat na již vytvořený
rig, který má být pro dosažeńı realistického a přirozeného výsledku vytvořen
pomoćı naskenovaných osob, jak bylo popsáno výše. Technologie MoCap má
stále své nedostatky a jej́ı proces neńı dostatečně automatizován. V některých
př́ıpadech může být časově výhodněǰśı vytvořit animaci ručně. Co se týče Mo-
Cap technologie na sńımáńı celého těla, tak jej́ı př́ınos je rozhodně obrovský
a jen d́ıky této technologii bylo možné jejich projekt Kingdom Come: Delive-
rance zvládnout.

2.2 Popis workflow vytvořeného v rámci
bakalářské práce

Ćılem práce je provést záznam emoćı, nikoliv záznam mluveńı, proto je
potřeba si vytvořit vhodný scénář, který by měl dostatečný rozsah po-
hybu mimiky a nálady herce. Pro dosažeńı lepš́ıch výsledk̊u animace a jej́ı
přirozenost bylo rozhodnuto provést sńımáńı pohyb̊u profesionálńı herečky
Kamily Janovičové.

2.2.1 Sńımáńı pohyb̊u obličeje

Prakticky celý proces sńımáńı pomoćı Vicon Cara prob́ıhá v následuj́ıćıch
fáźıch: propojeńı komponent̊u systému, nasazeńı helmy na herce, osvětleńı
a nastaveńı kamer, markerovańı, kalibrace, záznam herce.

Systém má speciálńı synchronizačńı a pamět’ové médium data station,
které se nazývá Cara Logger. Jeho funkce je kombinaćı dob́ıjećı baterie
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2.2. Popis workflow vytvořeného v rámci bakalářské práce

systému se synchronizaćı kamer a jejich záznamem na interńı SSD disk. Cara
Logger lze př́ımo propojit s poč́ıtačem śıt’ovým kabelem, nebo lze použ́ıt
interńı WiFi systém. Obecně je třeba mı́t interńı WiFi router a ideálně
i DHCP server, protože celý systém je automaticky nastaven i pro v́ıce
než jednoho herce. Jednotliv́ı aktéři jsou synchronizováni jedńım śıt’ovým
systémem, což je nesporná výhoda. Ovládaćı softwarový systém CaraLive
dává nejen přehled o existenci připojených systémů, ale obsahuje i diagnózu
jejich stavu. [19]

Po připojeńı zař́ızeńı Cara Logger se přistouṕı k nasazeńı helmy, která se
nazývá HeadRig, na hlavu sńımaného herce. Je d̊uležité pevně umı́stit helmu
tak, aby se zabránilo jej́ımu pohybu, a zároveň byla práce pro herce komfortńı.
Dále se provede nastaveńı pozic kamer, aby měly na záběru obličej herce,
provád́ı se ostřeńı a nastaveńı správné expozice. Pro kontrolu je k dispozici
CaraLive, která umožňuje sledovat záběry kamer v reálném čase.

Jakmile jsou provedena nutná nastaveńı systému, je možné přistoupit
k markerováńı herce. Daľśım krokem je zkontrolovat viditelnost marker̊u
všemi kamerami. Je potřeba se ujistit, zda je detekce marker̊u v pořádku,
v opačném př́ıpadě změnit parametry detekce, expozice nebo provést ručńı
ostřeńı. Kontrolovat je potřeba nejenom markery na obličeji, ale i samotnou
kalibračńı čelenku, protože ta slouž́ı k nepřetržitému srovnáváńı pozice kamer
v̊uči obličeji.

Po nastaveńı kamer následuje kalibrace. Kalibrace slouž́ı k tomu, aby
software CaraLive uložil informace o každé kameře, např́ıklad ohniskové
vzdálenosti nebo údaje o vzájemné poloze kamer. Kalibrace se dosáhne
zachyceńım informaćı z kalibračńı desky: pevné zař́ızeńı se vzorkem černých
blob̊u (teček) na b́ılém pozad́ı. Tento proces je potřeba provádět před prvńım
záznamem a na úplném konci sńımáńı herecké akce nebo po změně pozice
kamer. Kalibrace se provád́ı následuj́ıćım zp̊usobem: Headrig je umı́stěn
na speciálńım podstavci, spust́ı se sńımáńı a před kamerami se pohybuje
kalibračńı deskou. Jakmile je kalibračńı sńımáńı dokončeno, je potřeba data
převést do poč́ıtače, kde budou vyhodnocena jako kalibračńı. Pokud systém
potvrd́ı, že kalibrace proběhla v pořádku, je možné zač́ıt sńımáńı herce.

Po kalibraci je možné zač́ıt se sńımáńım. Doporučená délka jednoho
záznamu je do 5 minut. Toto omezeńı je dané daľśım zpracováńım dat
v CaraPost. Prvńı se provád́ı ROM záznam (Range of motion), který
obsahuje hercovu (kalibračńı) základńı mimiku. Jeho ćılem je pak vést
skutečný záznam v částech aktivńı mimiky. To znamená, že rozezná oblast
pro maximálńı i minimálńı pohyb jednotlivých blob̊u. Proto je potřeba,
aby herec v procesu sńımáńı takového záznamu zobrazil co největš́ı rozsah
emoćı a mimických výraz̊u. Po zaznamenáńı ROM je možné přej́ıt k sńımáńı
samotné herecké akce. Po sńımáńı je potřeba data uložit.
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2. Princip a postup sńımáńı obličeje

2.2.2 Čǐstěńı dat v CaraPost

Samotné zpracováńı dat ze sńımáńı prob́ıhá pomoćı softwaru CaraPost. Zpra-
cováńı se dá rozdělit na dvě části: vyčǐstěńı, pojmenováńı a nastaveńı ROM
záznamu a inicializace dat pomoćı již vyčǐstěného ROM záznamu. Prvńı fáze
čǐstěńı se zabývá samotnou detekćı blob̊u – je to pojem pro jednobarevné
body, markery na sńımku obličeje herce jsou detekovány CarouPost. Nasta-
vuje parametry pro dosažeńı co nejlepš́ı detekce. Dál následuje jejich pojme-
nováńı. Druhá fáze zač́ıná inicializaćı pomoćı ROM záznamu, a to znamená,
že se automaticky nastav́ı detekce blob̊u, marker̊u a jejich názvy. Daľśım kro-
kem je analýza dat a oprava možných chyb. Nejčastěǰśı chyby jsou šum v da-
tech, ztráta detekce marker̊u a špatná detekce marker̊u. Provád́ı se stabilizace
dat. Proces čǐstěńı se považuje za náročný na čas a komplikovaný. Důležité je
vyčistit data co nejpřesněji, t́ım se zlepš́ı kvalita výsledné animace.

2.2.3 Vytvářeńı skenu a 3D modelu

Pro zjednodušeńı vytvářeńı 3D modelu je dobré poř́ıdit sken obličeje herce.
Skenováńı herce se provád́ı markery, pro zjednodušeńı následuj́ıćı aplikace Mo-
Cap bodu na 3D model a bez marker̊u. Pro skenováńı je d̊uležité mı́t dobré
světelné podmı́nky pro dosažeńı kvalitńı textury. Rozlǐseńı textury je potřeba
nastavit co největš́ı, minimálně však 4K. Vytvořená sken ve formátu *.OBJ
se exportuje dál do 3D editoru – softwaru blender. Pomoćı skenu jde snadno
vytvořit retopologie modelu. Samotný sken nelze použ́ıt, protože nemá vhod-
nou topologii pro animaci. Topologie je zp̊usob, jak jsou rozmı́stěny hrany
na povrchu modelu. Dva povrchy mohou mı́t stejné tvary, ale r̊uznou topo-
logii. Topologie je d̊uležitá, protože má vliv na to, jak se mesh děĺı a defor-
muje. Dobrá topologie zajǐst’uje, že deformace vypadaj́ı přirozeně, v opačném
př́ıpadě se model deformuje špatně a vypadá nerealisticky. [25] Po vytvářeńı
retopologie hlavy se aplikuje textura skenu na 3D model pomoćı funkce Bake
v blenderu. 1 [26]

2.2.4 Vytvářeńı rigu a aplikace dat

Rigováńı se vytvář́ı pomoćı metody diskrétńıch kost́ı (kv̊uli nedostatku
zkušenost́ı vybráno jako nevhodněǰśı). Metoda spoč́ıvá ve vytvářeńı kost́ı
v mı́stech umı́stěńı marker̊u na obličeji herce s následuj́ıćı aplikaćı MoCap
bodu na ně. Po aplikaci nasńımaných dat je potřeba zkontrolovat animaci
a naj́ıt možné chyby, provést čǐstěńı a úpravu problematických část́ı pomoćı
Shape key (funkce v blenderu). [25] Některé problémy se daj́ı vyřešit
překreslováńım váhy jednotlivých kost́ı pomoćı Weight paint.

1Tučný text se použ́ıvá pro funkce v blendru
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2.2. Popis workflow vytvořeného v rámci bakalářské práce

2.2.5 Vytvářeńı a animace př́ıslušných čast́ı hlavy

Zachyceńı pohyb̊u pomoćı Vicon Cara nesleduje pohyb oč́ı ani zub̊u, proto je
potřeba je animovat ručně. Samotný 3D model oč́ı a zub̊u je možné stáhnout
nebo vymodelovat pomoćı referenčńıho obrázku. Animace mrknut́ı se vytvář́ı
pomoćı Shape key s následuj́ıćım kĺıčováńım ve správný čas. Kĺıčové sńımky
(keyframes) jsou základem animace. Definuj́ı hodnotu dat v určitém čase. Po-
hyb oka se vytvář́ı pomoćı Constraint Track to. Pohyb zub̊u neńı potřeba
kĺıčovat ručně. Stač́ı použ́ıt již nasńımané MoCap body, např́ıklad pro spodńı
čelist využ́ıt rotaci pohybu brady. Vrchńı čelist se pohybuje spolu s hlavou,
takže stač́ı jenom následovat jej́ı pohyb. Vytvořenou animaci je potřeba zkon-
trolovat s videoreferenćı a provést potřebné úpravy.

2.2.6 Finálńı zobrazeńı - render

Pro render je potřeba správně nastavit scénu, kameru, použ́ıt vhodná světla,
nejlépe HDRI, nastavit kvalitu renderu, formát výstupńıho souboru a daľśı pa-
rametry. Renderovat animace je potřeba ve formě obrázku. Sekvence obrázk̊u
pak převést do videa.
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Obrázek 2.4: Navržený postup po vytvářeńı obličejové animace26



Kapitola 3
Praktická část

V praktické části je popsán celý produkčńı řetězec vytvářeńı animaćı od
vytvářeńı scénáře do výsledného renderu. Zač́ıná se tvorbou scénáře a do-
mluvou s hercem. Po př́ıpravě materiálu je možné zač́ıt práci v MoCap studiu.
Nejprve se nastav́ı systém Cara pro sńımáńı obličeje, připrav́ı se herec a za-
znamená se herecký výkon. Poté následuje post-processing, tedy zpracováńı
a očǐstěńı źıskaných dat. Dále představ́ıme tvorbu 3D syntetického modelu
lidské hlavy a zp̊usob aplikováńı nasńımaných dat na vytvářený model. Ne-
chyb́ı popis častých problémů a jejich možná řešeńı při aplikováńı a zpracováńı
MoCap dat. Následně je ukázáno, jak se vytvář́ı animace kombinaćı MoCap
dat a ručńı animace. Závěr poskytuje pohled na screenshoty (sńımky obra-
zovky) výsledné CG animace a zhodnoceńı výsledné animace.

3.1 Scénář

Ćılem práce je zaměřit se na sńımáńı emoćı obličeje, nikoliv na zachyceńı
mluvy herce. Proto je potřeba mı́t scénář, který obsahuje několik r̊uzných
emoćı, nejlépe od sebe odlǐsných. Tvorba scénáře je inspirována hereckou akćı.
[27] Čte se text a herec má za úkol hrát emoce v reálném čase podle děje, který
uslyš́ı. Pro tuto práci je vytvořen scénář ”Zmrzlina“, který je uveden v tabulce
3.1.

3.2 Źıskáváńı MoCap dat

Záznam hereckého výkonu proběhl dle předem vytvořeného scénáře. Pr̊uběh
tohoto výkonu je vhodné natočit i na exterńı kameru (mimo systém Cara)
jako referenci pro daľśı práci a úpravy. Źıskáńı MoCap dat lze rozdělit do
několika následuj́ıćıch krok̊u: počátečńı nastaveńı, kalibrace, markerováńı
obličeje a záznam hereckého výkonu.
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Tabulka 3.1: Text scény Zmrzlina

Text Reakce herce

Jdeš s rodiči po ulici, nuda
najednou vid́ı̌s stánek se zmrzlinou. překvapeńı
Dostaneš strašnou chut’ na zmrzlinu. chut’, touha
“Tati, prośım, kup mi zmrzlinu, prośım.” louděńı
“Dobře, tak ti ji kouṕıme. Tady máš zmrzlinu.” štěst́ı, potěšeńı
Najednou ti spadne na tričko. šok, smutek
“Tati, kup mi ještě jednu?” louděńı

3.2.1 Počátečńı nastaveńı

V laboratoři Západočeské univerzity v Plzni byl systém již nainstalován a li-
cencován, je tedy možné zač́ıt s počátečńım nastavováńım. Po spuštěńı pro-
gramu CaraLive je potřeba počkat na navázáńı komunikace s Loggerem. Stav
připojeńı je možné kontrolovat na záložce Logger Control viz obrázek 3.1.
Modrou barvou jsou reprezentovány připojené komponenty (např́ıklad baterie,
Wi-Fi, LAN, pamět’ loggeru, synchronizace a 4 kamery). Pakliže je s kompo-
nenty nějaký problém, jsou znázorněny červenou barvou. Po připojeńı všech
požadovaných komponent̊u se nastav́ı cesta ukládaných sńımaných soubor̊u.
Následně lze otevřeńım okna s detailńımi pohledy kamer a jejich nastaveńım
upravovat parametry pro streaming, spouštět nahráváńı a kalibraci.

Obrázek 3.1: Informace o připojeńı

Po nastaveńı programu je třeba připravit HeadRig (helma). Při každém
nasazeńı helmy na hlavu herce je d̊uležité ji pevně umı́stit, aby se minimali-
zovali vibrace. Na helmě je potřeba nastavit pozici kamer na tvář herce a ka-
libračńı čelenku. Správnost nastaveńı lze pozorovat na monitoru. Na záložce
Camera je možné kamery zaostřit a nastavit expozice (ručńı nebo automa-
tické nastaveńı). Záložka Calibration umožňuje nastaveńı Detect Blobs →
Find black blobs / Find white blobs kalibračńı čelenky dle barev bod̊u.
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3.2. Źıskáváńı MoCap dat

Obrázek 3.2: Nasazená helma Vicon Cara

3.2.2 Kalibrace

Pro provedeńı kalibrace je zásadńı si pojmenovat kalibračńı záznam v záložce
Logger Control. Pro natočeńı tohoto záznamu je nutné sejmout HeadRig
z hercovy hlavy, zakrýt kalibračńı čelenku st́ıńıtkem a připravit kalibračńı
desku. Po provedeńı těchto opatřeńı je možné spustit záznam tlač́ıtkem Start
Capturing a to pro každou kameru postupně:

• držet kalibračńı desku Vicon Cara před kamerou a pomoćı náhledu na
monitoru zajistit, aby byly všechny bloby detekovány,

• od plného vyplněńı kamery kalibračńı deskou postupným oddalováńım
kalibrovat rozpoznáváńı blob̊u,

• postupně otáčet kalibračńı desku kolem svého středu až o 45 stupň̊u
oběma směry.

Po ukončeńı nahráváńı pomoćı tlač́ıtka Stop Capturing je možné záznam
stáhnout, a poté shlédnout stisknut́ım Preview. V př́ıpadě potřeby lze změny
provést v nastaveńı zvoleńım Calibrate. V kartě Local Captures je zobra-
zený stav a pr̊uběh kalibrace. Po jej́ım dokončeńı se stav změńı na Comple-
ted.

3.2.3 Markerováńı obličeje

Při markerováńı obličeje byly k dispozici pouze válcovité body a nešlo tedy
využ́ıt v́ıce druh̊u bod̊u pro dosažeńı optimálńıho výsledku. Tyto použité mar-
kery lze pozorovat na obrázku 3.4. Vhodné je zač́ıt markerovat až po nasazeńı
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Obrázek 3.3: Kalibrace Vicon Cara, sńımáńı pohybu kalibračńı desky

helmy na hercovu hlavu, protože je možné sledovat viditelnost marker̊u na
kamerách.

3.2.4 Záznam herce

Před nahráńım hereckého výkonu podle předem připraveného scénáře se na-
hraje ROM záznam. Ten se vytvoř́ı na kartě Logger Control následuj́ıćım
postupem: vytvořeńı názvu, stisknut́ı Logger a kontrola zaostřeńı, vybráńı
I/P/B-frames a stisknut́ım Start Capturing v sekci Streaming.

Po poř́ızeńı ROM záznamu muśı herec provést několik kalibračńıch cvičeńı.
Zač́ıná a konč́ı se přirozenou mimikou (neutrálńı výraz) obličeje, kterou lze
prokládat i ostatńı cviky. Pro ukončeńı záznamu slouž́ı tlač́ıtko Stop Captu-
ring. V záložce Remote Capture se nacháźı právě vytvořený ROM záznam,
který lze stáhnout tlač́ıtkem Download.

Nahráńı scénáře prob́ıhá podobně jako vytvářeńı ROM záznamu. Velice
užitečné je natočit celou akci zaznamenáńı pohybu pomoćı 4K kamery, aby
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Obrázek 3.4: Rozložeńı marker̊u na obličeji

Obrázek 3.5: Záznam herečky Kamily Janovičové

byla po následuj́ıćım zpracováńı dat a vytvářeńı animace dostupná reference
pohybu obličeje.

V př́ıpadě chybného připojeńı kamery během nahráváńı záznamu nebo
vypadnut́ı marker̊u je potřeba nahrát záznam znovu. Neexistuje jednoduchý
zp̊usob, jak v post-processingu zmizeńı marker̊u spravit. Proto je d̊uležité
během zaznamenáváńı herce a také mezi jednotlivými záznamy kontrolovat
umı́stěné markery.
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3.3 Post-processing

Pracovńı postup v CaraPost dá se rozdělit na dvě části:

• zpracováńı ROM záznamu,

• inicializace pomoćı zpracovaného ROM záznamu.

3.3.1 Zpracováńı ROM záznamu

Pro zpracováńı ROM záznamu je potřeba učinit následuj́ıćı kroky:

1. Spustit Vicon CaraPost.

2. Importovat soubory zachyceńı pohybu. V nově otevřeném programu
v horńı paletě je potřeba zvolit File → Import pico Files, t́ımto
se načte ROM záznam. Pro zobrazeńı všech kamer je možné použ́ıt
předposledńı ikonu pod paletou možnost́ı. T́ımto se zobraźı 4 záběry
z kamery umı́stěné paralelně vedle sebe.

Obrázek 3.6: Rozložeńı kamer pro zobrazeńı

3. Nastavit parametry blob̊u. Nastaveńı detekce blob̊u se ulož́ı do sńımku,
který byl zachycen zař́ızeńım Vicon CaraLive, takže neńı potřeba měnit
žádné parametry.

4. Detekovat bloby. Pomoćı volby z karty Process → Detect Blobs
(current frame) se detekuj́ı bloby na jednou vybraném sńımku. Pro
grafické zobrazeńı blob̊u na kameře je nutné zvolit Detect Blobs a Pro-
jecting pro prostorové zobrazeńı blob̊u. V pravé části hlavńıho okna
Properties v nab́ıdce Blob parametrs lze nastavit velikost blob̊u
(Black Min/Max Radius). Daľśı krok zvolit v kartě Process → De-
tect Blobs (active range), t́ım se detekuj́ı bloby v následuj́ıćı framech.
Pokud jsou některé z náhled̊u kamer obrácené, tak podržeńım CTRL,
je potřeba označit kamery myš́ı. Až budou názvy kamer zelené, dvakrát
zmáčknout šipku doprava.

5. Inicializovat kalibračńı čelenku. Nyńı je potřeba otevř́ıt nové okno
s kalibračńım brimem pomoćı Process → Inicialize default calib-
ration brim [v2.0], načte se čelenka a potom View → New floating
workspace (3D) se otevře nové okno, kde je 3D náhled kalibračńı
čelenky. Označit bod na čelence je možné levým tlač́ıtkem na myši, pak
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CTRL + levým tlač́ıtkem myši označit odpov́ıdaj́ıćı bod na každém
z pohledu kamery. Poté je potřeba stisknout M (merge), t́ım se vytvoř́ı
asociace (fialové zbarveńı). Takto je potřeba postupovat čtyřikrát pro 4
body v extrémńıch pozićıch na čelence. Poté v kartě Process → Solve
calibration brim.

Obrázek 3.7: Propojeńı blob̊u na záběru kamer s bloby čelenky

6. Inicializovat pozice marker̊u na obličeje. Ćılem tohoto kroku zpracováńı
je správná inicializace pozic všech marker̊u obličeje, které chceme sle-
dovat, a aby bylo zajǐstěno, že jsou ve všech zobrazeńıch kamery, ve
kterých jsou viditelné, nalezené odpov́ıdaj́ıćı detekce. Na náhledu kamer
je potřeba označit postupně čtyři odpov́ıdaj́ıćı body na obličeji CTRL
+ levé tlač́ıtko myš́ı a po označeńı M (stejným zp̊usobem, jako na
čelence). Takto se vytvoř́ı čtyři až pět bod̊u, které jsou vidět žlutě ve 3D
okně. Process → Bundle current frame, t́ım se zaktualizuje poloha
virtuálńıch kamer v 3D okně. Process → Initialize 3D se dopoč́ıtaj́ı
a zobraźı zbylé bloby z tváře pomoćı algoritmu s trigonometríı. Výsledné
body jsou vidět ve 3D okně.

33



3. Praktická část

Obrázek 3.8: Náhled kamer po 3D inicializace

7. Označit markery na obličeje. Po dokončeńı inicializace je užitečné označit
značky tak, aby je bylo možné snadno identifikovat nebo naj́ıt chyby při
sledováńı. Soupis se vlož́ı přes File→ Import labeling frame (*.txt).
Z části Labeling je nutné přǐradit názvy ze seznamu k marker̊um.

Obrázek 3.9: Seznam marker̊u na Labelling pane

8. Vytvořeńı modelu, śıtě (mesh). Je možné si vytvořit śıt’ mezi body pro
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snazš́ı pozorováńı pohyb̊u a čǐstěńı dat. Proto je potřeba označit 2 body
(CTRL + levé tlač́ıtko myši) a stisknout S (stick), tak se vytvoř́ı spoj
mezi body. Postupně je potřeba spojit daľśı body. Alternativně přes Edit
→ Create stick mesh se vytvoř́ı spojeńı mezi všemi body. Po označeńı
nechtěných spojeńı CTRL+D se spojeńı odstrańı.

Obrázek 3.10: Vytvořeńı 3D modelu

9. Sledováńı zbytku záběru. Když je nastavena pozice kamery a 3D re-
konstrukce pro prvńı sńımek, je možné sledovat zbytek sńımku. Výchoźı
parametry uvedené v následuj́ıćım př́ıkladu by měly fungovat dobře pro
většinu situaćı. Process → Track Forwards (Single Frame) sleduje
jen jeden frame dopředu, je potřeba zkontrolovat nadcházej́ıćı sńımek
(kolečkem na myši), pokud chyba neńı nalezena, tak se vrátit o frame
zpět a zvolit Process → Track Forwards (Sequence), tato sekvence
slouž́ı k označeńı bod̊u v celém záznamu.
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Obrázek 3.11: Parametry sledováńı

10. Uložit dokončený vzorek. Jakmile je inicializace provedena a markery
jsou označeny, je nutné uložit soubor pro daľśı export. File → Save.

3.3.2 Inicializace pomoćı zpracovaného ROM záznamu,
čǐstěńı

Aby nebylo třeba opakovat ručńı proces inicializace a označováńı 3D
s následným pojmenováńım, je možné po dokončeńı čǐstěńı souboru ROM
uložit na disk ROM soubor a potom použ́ıt jeden z jeho sńımk̊u k inicializaci
ostatńıch soubor̊u zachyceńı pohybu. Markery a jména se přenášej́ı do nového
záznamu.

Obrázek 3.12: Nahraná ROM informace do záznamu
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Pro automatické zpracováńı záznamu pomoćı ROM je potřeba vybrat
File → Impert pico. Pak Process → Load from ROM. Takto načteme
ROM záznam, který je zobrazen modrými kroužky. Pro automatickou detekci
a trackovańı je potřeba zvolit v kartě Process → Initialize from ROM.
Daľśım krokem je čǐstěńı a optimalizace záznamu. Ćılem čǐstěńı a optimalizace
je použ́ıt počátečńı výsledky sledováńı, pak použ́ıt kombinaci ručńıch a au-
tomatických nástroj̊u k opravě př́ıpadných chyb v datech a vyplněńı všech
mezer. Nejčastěji docháźı k následuj́ıćım chybám:

1. Chyby sledováńı.
Sledováńı chyb je velmi časově náročné na ručńı opravu, takže pokud
jsou chyby sledováńı na v́ıce než několika bodech, má smysl vrátit se zpět
a opakovat automatické sledováńı pomoćı vhodněǰśı sady automatických
parametr̊u sledováńı. Pokud však jsou chyby sledováńı jen na několika
bodech, je možné odstranit špatné výsledky sledováńı ručně.

2. Zrušené nebo chyběj́ıćı markery.
Pro opravu této chyby je potřeba přej́ıt do sńımku, kde sledováńı nese-
lhalo, vybrat bod. J́ıt dopředu o sńımek, kde bod zmiźı, a zvolit nevy-
brané bloby v jakémkoli chyběj́ıćım zobrazeńı kamery. Dále je potřeba
stisknout M pro sloučeńı bod̊u. Pak zvolit sloučený bod a v nab́ıdce
Proces → Track Forwards[Sequence].

3. Selháńı sledováńı blob̊u.
Selháńı sledováńı blob̊u nastává z d̊uvod̊u nedostatku kontrastu. Tato
situace se dá zlepšit pomoćı změny parametr̊u v nastaveńı expozice.
Jinak je potřeba vybrat bod na sńımku, než se ztrat́ı. Pak nastavit modrý
vnitřńı čtverec tak, aby odpov́ıdal velikosti markeru, který je sledován.
Nakonec je potřeba vybrat Process→ Interpolate Gaps.

4. Špatné sńımky kamery.
Tahle chyba nastává např́ıklad tehdy, když se sledovaný bod nacháźı na
kraji tváře a má malou velikost nebo zmiźı. Pro opravu je potřeba přej́ıt
na prvńı sńımek, pak View → Set Active Range Start, pak přej́ıt
na posledńı sńımek, kde je záznam v pořádku, zmáčknout View → Set
Active Range End. Pak je potřeba odpojit detekce Edit → Detach
Detections [Active Range].

5. Sloučené bloby.
Body, které se př́ılǐs přibĺıž́ı a pak slouč́ı, jsou zobrazovány jako skoky
bodu v 3D pohledu. Pro vyřešeńı tohoto problému je potřeba přidat
body ručně a znova zpustit sledováńı. Process → Track Forwards.
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6. Interpolované vyplňováńı mezery.
V některých situaćıch chyb́ı bod ze všech čtyř kamer. Např́ıklad mo-
hou být markery skryty pod záhyby pokožky nebo během extrémńı
obličejového výrazu. Vicon CaraPost může vyplnit tyto mezery v da-
tech pomoćı inteligentńı interpolované výplně. Process → Interpolate
gaps.

Podrobná řešeńı jsou popsaná v CaraPost user guide viz Př́ıloha. Po čǐstěńı
je potřeba záznam uložit, je možné vybrat formát *.C3D nebo *.BVH. File
→ Export C3D or Export FBX.

3.4 Vytvářeńı syntetického modelu

Naskenovaný model je ve formátu OBJ, jenž lze naimportovat do blenderu
pomoćı File → Import OBJ. Model je třeba umı́stit do středu a správně
nasměrovat náhledy. Dále je potřeba vytvořit plochu s počátkem ve středu
modelu. Daľśım krokem je pak aplikováńı Mirror modifier na tuto plochu.
Základńım nástrojem retopologie je Snap tool umožňuj́ıćı umı́stit vrchol na
povrchu referenčńı hlavy automaticky.

Obrázek 3.13: Naskenovaný model herečky

Tvorbu retopologie je možné zač́ıt obtahováńım tvaru oka s následným ex-
trudováńım. Veškeré operace se prováděj́ı se zapnutým Snap toolem. Daľśım
užitečným modifikátorem je Subdivision surface, který vytvář́ı virtuálńı
zvětšeńı polygon̊u. Nejčastěji se použ́ıvá při vytvářeńı organických objekt̊u.[26]
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Obrázek 3.14: Extrudováńı vrchol̊u oka

Pro zvětšeńı podoby referenčńıho modelu hlavy herečky a vytvořeného
modelu je možné použ́ıt modifier Shrinkwrap, který umožňuje zachytit
v́ıce detail̊u ve tváři. modifier Shrinkwrap umožňuje objekt ”zmenšit“ na
povrch jiného objektu. Přesune každý vrchol objektu, který je upraven, na
nejbližš́ı polohu na povrchu daného modelu (pomoćı jedné ze tř́ı dostupných
metod). Pro nejlepš́ı výsledek se tento modifikátor použ́ıvá pouze na vrcholy
ve tváři.

Obrázek 3.15: Porovnáńı modelu s referenćı
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Obrázek 3.16: Výsledek po použit́ı modifier Shrinkwrap

Následovně je použita ručńı úprava modelu, předevš́ım kolem oč́ı a krku.
Daľśım krokem je vyhlazeńı a kontrola normál. Na vyhlazeńı existuje modi-
fier Corrective smooth, který umožňuje dosáhnout lepš́ı kvality výsledného
modelu a zmenšuje artefakty st́ın̊u při renderováńı. Nevýhodou může být
zp̊usobeńı ztráty detailu, proto se nepouž́ıvá př́ılǐs vysoký faktor parametr̊u.

Obrázek 3.17: Plochy na které se aplikuje modifier Corective smooth

Důležité je také upravit oblast uvnitř úst, kde se později budou nacházet
zuby a jazyk. Pro zjednodušeńı práce lze nepotřebné vrcholy skrýt. Toho lze
doćılit extrudováńım rt̊u, oblast pak bude mı́t vlastńı texturu a materiál.

Častým artefaktem při modelováńı je černá oblast v modelu. Tento
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problém je spojen s nekonzistentńımi normálami. Normály určuj́ı směr
orientace plochy a všechny propojené plochy by měly být natočené stejným
směrem. Opravit to je možné pomoćı operace recalculate normals Crtl
+ N.

Hotový 3D model lze uložit ve formátu .OBJ nebo .blender.

Obrázek 3.18: Výsledný syntetický 3D model

3.5 Aplikace źıskaných dat na 3D model

Pro animováńı 3D hlavy obličeje je potřeba si vytvořit rig, aplikovat na něj
MoCap data a opravit možné chyby. Rig se vytvář́ı metodou diskrétńıch kosti,
která je považována za nejjednodušš́ı a kv̊uli nedostatku zkušenost́ı za nej-
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vhodněǰśı. Po aplikaci dat je potřeba zkontrolovat animaci kv̊uli možným
chybám. Nejčastěji se pro opravu použ́ıvá funkce v blenderu Shape key.

3.5.1 Vytvářeńı kostry a jej́ı aplikováńı pomoćı MoCap dat

Práce zač́ıná nastaveńım rozš́ı̌reńı v blenderu. Je třeba, aby blender uměl
import a práci s formátem .C3D. Nastaveńı je možné naj́ıt pomoćı Filter
→ User Preferences, dále vybrat kartu Add-ons v části Categories zvolit
Import-Export a poté povolit Import-Export: C3D Graphics Lab Mo-
tion Capture file (.C3D) a následně uložit nastaveńı Save User Setting.
Pak je dobré umı́stit kurzor na střed, aby se zde nacházel origin naimporto-
vaných dat. Ted’ je možné naimportovat nasńımaná data do blenderu File →
Import → C3D. Parametry importu jsou uvedené na obrázku 3.19.

Obrázek 3.19: Import MoCap dat

Pro usnadněńı operaćı transformace, se vytvoř́ı kost, která bude rodičem
MoCap bodu. Kost umı́st́ıme na střed, viz obrázek 3.20.
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Obrázek 3.20: Nastaveńı závislosti vytvořené kosti

Následně je možné provést transformace zvětšeńı, zmenšeńı, posun a ro-
tace jednodušeji. Nyńı je potřeba body umı́stit tak, aby odpov́ıdaly reálným
marker̊um na herce. Důležité je zkontrolovat umı́stěńı bodu ze všech stran.
Pro nejpřesněǰśı výsledek je možné využ́ıt reference, bud’ naskenovaný model
s markery, nebo fotografii herečky.

Je možné změnit tvar bod̊u, aby v́ıce odpov́ıdaly skutečným marker̊um
a také pro zjednodušeńı daľśı práce. V pravém panelu v položce Dat je potřeba
změnit Display → Sphere a nastavit velikost podle potřeby. Viz obrázek
3.21.

Obrázek 3.21: Nastaveńı tvaru MoCap bodu

Daľśım krokem je vytvářeńı kosti pro hlavu a krk, což bude základem pro
armaturu Add → Armature → Rigg, v edit mode umı́stit kost doprostřed
krku a extrudovat nahoru. Tyto kosti budou ř́ıdit pohyb krku a hlavy.
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Obrázek 3.22: Základ armatury

Kost, která má být umı́stěna uprostřed hlavy, bude ř́ıd́ıćı pro všechny
kosti ř́ızené MoCap body. Pro každý MoCap bod je potřeba vytvořit kost
v edit mode duplikováńım kost́ı. Je dobré si je pojmenovat stejným zp̊usobem
jako odpov́ıdaj́ıćı MoCap body. Důležité je, aby vytvořená kost byla perfektně
umı́stěna na středu MoCap bodu. Toho je možné dosáhnout operaćı Snap to.
Po výběru MoCap bodu je potřeba zmáčnout SHIFT + S Cursor to se-
lected, pak zvolit kost, přej́ıt do edit mode a zvolit SHIFT + S Selection
to cursor, viz obrázek 3.23.

Obrázek 3.23: Umı́stěńı kosti v centru MoCap bodu

Dále je potřeba kost rozpohybovat, v Pose mode v Properties →Bone
Constraint →Add Bone Constraint→Child Of v části ćıl (Target) je
potřeba zvolit bod s ćılem (názvem), který odpov́ıdá pozici s kost́ı, a zvolit
set inverse. Parametr Influence se nastav́ı později podle potřeby. Operace
vytvářeńı a nastaveńı rodiče je nutné provést pro všechny MoCap body. Pro
zmenšeńı práce s Weight paint je potřeba vytvořit dvě kosti nav́ıc a umı́stit
je u r̊ustu vlas̊u a daľśı dvě kosti umı́stit uprostřed oč́ı 3.24. T́ımto je možné
zlepšit vygenerováńı automatické váhy.

44
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Obrázek 3.24: Nastaveńı rodiče kosti

Kv̊uli tomu, že bylo rozhodnuto animovat mrkáńı ručně pomoćı Shape
key, MoCap bod odpov́ıdaj́ıćı za pohyb v́ıčka neńı třeba provázat s kost́ı.
Tento bod využijeme později při nastaveńı času mrkáńı.

Daľśım krokem je provázat armaturu a hlavu. V object mode je potřeba
vybrat hlavu a vytvářenou armaturu (pořad́ı je d̊uležité), pak zmáčknout
CTRL + P a zvolit With automatic weight. Automatické váhy jsou
většinou nejlepš́ı volbou, tyto možnosti přidávaj́ı Armature modifier a na-
stav́ı vybranou kostru tak, aby p̊usobila jako deformátor. Automatické váhy
detekuj́ı kosti nejbĺıže vrchol̊um a automaticky přǐrad́ı váhy na základě této
vzdálenosti.
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Obrázek 3.25: Finálńı armatura hlavy

3.5.2 Řešeńı problému při animaci

Po provázáńı armatury a modelu je možné se pod́ıvat na animaci a naj́ıt
veškeré problémy a jejich možná řešeńı. Ovládáńı animace se nacháźı v panelu
TimeLine. Po zobrazeńı animace se objevily následuj́ıćı problémy:

• pohyb očńıho otvoru,

• pohyb rt̊u,

• šum bodu.
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Každý z problémů je možné řešit a každý vyžaduje sv̊uj vlastńı zp̊usob.
Pohyb očńıho otvoru
Funkce v blenderu nastaveńı automatické váhy velice dobře poč́ıtá, jak moc

má ovlivnit kost svou část hlavy, ale neńı to vždycky ideálńı. Jedńım z př́ıpad̊u,
který neńı ideálńı, je pohyb očńıho otvoru nahoru a dol̊u, což neodpov́ıdá lidské
anatomii. Tuto chybu je možné odstranit překresleńım váhy kosti. V Weight
paint mode štětcem Add nebo Substract dokreslit nebo ubrat váhu u kost́ı
kolem oč́ı. Měkkost štětce je možné upravovat křivkami pro dosažeńı lepš́ıho
výsledku.

Obrázek 3.26: Ukázka upraveńı váhy kolem oč́ı

Pohyb rt̊u
Daľśım problémem je pohyb rt̊u. Na obrázku je vidět, jak se rty špatně

překrývaj́ı. Takový pohyb neńı pro MoCap systém jednoduchý a chyba byla
očekávaná. Nastává kv̊uli nedostatku marker̊u a celkové složitosti pohybu.
Takovéto drobné chyby v modelu se většinou opravuj́ı pomoćı Shape key
animaćı. Shape key ukládá stavy objektu s následuj́ıćı možnost́ı mı́cháńı
z jednoho do druhého. [25]
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Obrázek 3.27: Porovnáńı problematického mı́sta s referenćı

Pro vytvářeńı Shape key je potřeba přej́ıt do panelu v Data → Shape
Key zmáčknout plus. Vytvoř́ı se položka s názvem Basic. Toto je počátečńı
stav modelu, který má neutrálńı pozici. Pro vytvořeńı nového stavu je potřeba
zmáčknout plus ještě jednou. Novou položku je potřeba pojmenovat a následně
přej́ıt do edit mode. Ted’ je potřeba upravit model tak, aby se rty vzájemně
nepřekrývaly. Nastavit śılu mı́cháńı stavu je možné pomoćı položky Value,
která se nacháźı pod panelem Shape Key.

Obrázek 3.28: Použit́ı Shape key pro úpravu rt̊u

Ted’ je nutné přidat kĺıčové sńımky s upraveným stavem rt̊u do problema-
tických mı́st. To je možné udělat pomoćı tlač́ıtka I - insert, kurzor má být
u panelu Value. T́ımto zp̊usobem se vytvář́ı sńımek, upravovat ho je možné
v panelu Dope Sheet nebo Graph Editor.

Šum bodu
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Markery u rt̊u jsou hodně problematické, protože často miźı detekce při
sńımáńı. Šum byl vyčǐstěn v aplikaci CaraPost, ale jak lze v tomto stádiu po-
zorovat, nedošlo k dostatečnému vyčǐstěńı. Jeden bod u rt̊u má stále chaotický
pohyb – šum. Naštěst́ı je možné zmenšit šum i v blenderu. Je potřeba vybrat
problematický MoCap bod a přej́ıt do Graph editor. Je potřeba vyřešit,
v jaké ose se nežádoućı pohyb nacháźı a a zvolit ji, aby bod nebyl upraven
na jiné ose. Pak je potřeba označit sńımky, kde se problém vyskytuje, a zvolit
Key → Smooth Keys. Pod́ıvat se na výsledek, zda je pohyb dostatečně
upraven, v opačném př́ıpadě opakovat operaci.

Obrázek 3.29: Odstraněńı šumu pomoćı Smooth Keys

3.6 Vytvářeńı a animace př́ıslušných čast́ı hlavy

Zaznamenat pohyb oč́ı a zub̊u pomoćı Vicon Cara neńı možné, proto je
potřeba si vytvořit animaci ručně. Pro animaci se použije poř́ızené video
během sńımáńı pohybu herečky jako reference.

3.6.1 Vytvářeńı modelu oka

Pro vytvářeńı oka je možné použ́ıt referenčńı obrázek pro vymodelováńı
správného tvaru. Model oka se bude skládat ze dvou část́ı – z bělma
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a duhovky. Každá část bude mı́t vlastńı texturu, materiál.

Obrázek 3.30: Tvar oka: bělmo, duhovka

Pro vytvářeńı druhého oka je vhodné použ́ıt Mirror modifier. Při tomto
origin oka muśı být umı́stěn na stejné pozici jako origin hlavy.

3.6.2 Animace: koukáńı

Bylo rozhodnuto animovat oči pomoćı Constraints Track to, pro začátek
je potřeba vytvořit dvě kosti jednu pro samotné oko a jednu, která muśı být
nastavena jako rodič prvńı kosti, jako v obrázku 3.31. Na prvńı vytvořené
kosti se použije operace CTRL + P With automatic weights. Důležité
je pojmenovat objekty, protože pro daľśı použit́ı se muśı kosti vybrat podle
jména. Dále je potřeba vytvořit kosti, které budou sloužit jako trackovaćı bod
pro oči. Tyto kosti vytvoř́ıme zkoṕırováńım očńıch kost́ı, které poté nastav́ıme
jako constrain Track to u kost́ı oč́ı.

Obrázek 3.31: Armatura oči
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Obrázek 3.32: Kosti pro pohyb oč́ı: na pravé části kosti oka, na levé straně
trackovaćı kosti

Obrázek 3.33: Nastaveńı Constraint Track to

Následně je možné pohybem kontroleru ovlivňovat, kam koukaj́ı oči a to
pomoćı pose mode. Daľśım krokem je ručně nakĺıčovat sńımky podle video
referenćı.

3.6.3 Animace: mrknut́ı

Čas mrknut́ı je zaznamenán pomoćı MoCap bodu odpov́ıdaj́ıćıho za horńı
v́ıčko. Animace pohybu v́ıčka se vytvoř́ı pomoćı Shape Key. Jeden stav
bude Basic s otevřenýma očima, druhý blink s očima zavřenýma. Je potřeba
nezapomenout animovat i dolńı v́ıčko, protože při mrknut́ı se pohybuj́ı v́ıčka
obě. Stač́ı upravit jenom jedno oko a pak zvolit Mirror v panelu Shape key.
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Obrázek 3.34: Animace oč́ı podle referenćı

Dál je potřeba nakĺıčovat sńımky podle pohybu MoCap bodu od-
pov́ıdaj́ıćıho za v́ıčko. Podle referenćı je vidět, že pohyb neńı stejný, oko
se zav́ırá rychleji a otev́ırá se pomalu. Takové drobnosti pomůžou kvalitě
výsledné animace.

Obrázek 3.35: Stavy animace mrknut́ı

3.6.4 Vytvářeni modelu čelisti

Daľśı d̊uležitou součást́ı lidské tváře jsou zuby a jazyk. Zuby maj́ı složitý tvar
a pro zjednodušeńı práce je možné použ́ıt hotový model zub̊u. Model použitý
v této práci je možné stáhnout na www.blendswap.com/blends/view/77173.
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3.6. Vytvářeńı a animace př́ıslušných čast́ı hlavy

3.6.5 Animace čelisti

Přestože pohyb čelisti neńı zaznamenán zachyceńım pohybu, je možné použ́ıt
některé body jako ř́ıd́ıćı, takže neńı potřeba vytvářet ručńı animaci. Pro horńı
čelist je potřeba vytvořit kost a umı́stit ji doprostřed modelu. Pro spodńı čelist
je umı́stěńı kosti specifické. Úhel bude mı́t stejný, jako brada viz obrázek 3.37.
Pak je potřeba vytvořit armaturu, to je možné udělat označeńım zub̊u, pak
kost́ı (pořad́ı je d̊uležité) CTRL + P With automatic weights.

Obrázek 3.36: Model zub̊u

Je taky potřeba vytvořit třet́ı kost, která bude rodičem CTRL + P Set
parent to Bone. Pak je potřeba tyto kosti připojit k hlavě, tj. ke kosti, která
ř́ıd́ı pohyb hlavy. Vrchńı čelist se pohybuje spolu s hlavou, takže pro ni neńı
potřeba vytvářet děděńı od MoCap bodu, jej́ı pohyb už je správný. Pohyb
spodńı čelist má sṕı̌se podobu rotace než translace, takže pro něj neńı třeba
vytvořit Contrsints Child of ale Track to. Sledovat tuto kost bude MoCap
bod, který se nacháźı uprostřed brady. T́ım je pohyb čelisti vyřešen.

Obrázek 3.37: Umı́stěńı kosti ř́ıd́ıćı pohyb zub̊u
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3. Praktická část

Obrázek 3.38: Použit́ı Constraint na kost, odpov́ıdaj́ıćı za pohyb spodńı čelisti

3.7 Render

Po vytvářeńı animace je potřeba přej́ıt k renderováńı. Nejdř́ıv se nastav́ı
kamera a jej́ı parametry. Pro osvětleńı modelu je vhodné použ́ıt tři bodová
osvětleńı nebo HDRI světlo. Nejjednodušš́ı je použ́ıt HDRI obrázek, např́ıklad
fotku studia. Pro renderováńı videa neńı vhodné použ́ıvat funkce v blenderu
denoising, přináš́ı totiž nežádoućı šum, ale využit́ı obrázku ušetř́ı čas
a výrazně zlepš́ı kvalitu. Formát výstupńıho souboru zvoĺıme .png nebo
.jpg, video se renderuje, jako sekvence obrázk̊u a to z toho d̊uvod̊u, že pro
post-processing je v́ıce žádoućı sekvence obrázk̊u než video. Daľśı výhodou je
možnost použ́ıt alpha kanál. Ale hlavńı d̊uvod je možné nastaveńı renderováńı
a následuj́ıćı pokračováńı od posledńıho hotového sńımku.
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3.7. Render

Obrázek 3.39: Hotový 3D model hlavy
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3. Praktická část

Obrázek 3.40: Porovnáńı výsledné animace s referenćı
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3.7. Render

Obrázek 3.41: Porovnáńı výsledné animace s referenćı
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Závěr

Ćılem práce bylo nastudovat problematiku sńımáńı pohybu, źıskáńı přehledu
o existuj́ıćıch technologíıch a softwaru a využ́ıt technologii Vicon Cara pro
sńımáńı obličeje. Źıskaná data bylo potřeba zpracovat, vyčistit a aplikovat na
3D model s následnou tvorbou krátké CG animace. Celý produkčńı řetězec
byl zdokumentován a následně byl navržen kompletńı pracovńı postup sńımáńı
pohybu obličeje pomoćı Vicon Cara. Problémem při vypracováńı rešeršńı části
práce o možných zp̊usobech tvorby obličejové animace byl nedostatek odborné
literatury s uceleným popisem veškerého postupu práce a to hlavně z d̊uvodu
ochrany firemńıho know-how. Každá firma využ́ıvá sv̊uj vlastńı postup, který
zpravidla nebývá veřejně k dispozici. Daľśım d̊uvodem může být také ab-
sence jednoduchého postupu, který by nab́ızel kvalitńı výsledky s minimem
manuálńı práce.

Produkčńı řetězec vedoućı k vytvořeńı obličejové animace pomoci Mo-
Cap dat s následnou tvorbou krátké CG animace byl celý úspěšně proveden
a jeho výsledek lze vidět v př́ıloze. Během procesu byly nalezeny dále zmı́něné
problémy. Pohyblivost kalibračńı čelenky při prudkém pohybu herečky měla
za následek nežádoućı skoky bodu. Problém může být částečně vyřešen au-
tomatickou stabilizaćı, jež je k dispozici v posledńı verzi CaraPost. Rychlý
pohyb hlavou neńı obecně při sńımáńı obličeje doporučován, což může vést
k omezeńı herecké akce. Daľśım zjǐstěným problémem bylo animováńı po-
hybu vnitřńı části úst, přičemž ńızký počet marker̊u a složitost pohybu vedly
k potřebě ručńı úpravy animace po aplikováńı dat. Mrkáńı bylo taktéž třeba
animovat ručně vzhledem ke ztrátě detekce plochých marker̊u. Kv̊uli omezeńım
Vicon Cara bylo nutné manuálně animovat i čelist a pohyb oč́ı. Celý proces
lze zjednodušit využit́ım dodatečného softwaru pro zpracováńı dat zaměřený
např́ıklad na analýzu videa oproti potřebě sledováńı marker̊u nebo schopnosti
zaznamenat pohyb oč́ı, č́ımž se předejde značnému množstv́ı manuálńı práce.

Na výsledné animaci lze na některých mı́stech pozorovat nepřirozený po-
hyb zapř́ıčiněný nedostatkem zkušenost́ı v oboru – v ideálńım př́ıpadě se
model skládá z kost́ı, sval̊u a k̊uže. Daľśım d̊uvodem je zvolená metoda ri-
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gováńı pomoćı diskrétńıch kost́ı, což je nejsnadněǰśı metoda pro tvorbu ani-
mace. Problémem je, že manipulace s k̊už́ı neodpov́ıdá anatomickému pohybu
mimiky. Toto lze řešit vytvořeńım složitěǰśıho rigu za použit́ı 3D skenu herce
nebo manuálně. Přirozeněǰśıho výsledného vzhledu by šlo také doćılit užit́ım
větš́ıho počtu marker̊u.

Daľśım d̊uvodem vysvětluj́ıćım kvalitu animaci je velký rozsah práce.
V reálných projektech na tvorbě a animaci postav pracuje tým v rozsahu
tř́ı až několik deśıtek lid́ı. Celkový čas, který byl věnován praktické části
přesahuje 500 hodin, a stále je zde prostor pro daľśı vylepšeńı.

Přestože má vytvořená animace jisté nedostatky, vyjádřené emoce na mo-
delu jsou rozpoznatelné a vypadaj́ı živě. Záznam mimiky stále vyžaduje mnoho
manuálńı činnosti, proces dosud neńı plně automatizován, a tud́ıž maj́ı do-
stupné technologie daľśı prostor pro vývoj a zvýšeńı kvality.
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z: http://golfsciencelab.com/3-types-motion-capture-systems-
use/

[9] Brian Windsor, M. K.: MoCap for Artists. Focal Press, 2012, ISBN
0123694965.

[10] Menache, A.: Understanding Motion Capture for Computer Ani-
mation, 2nd Edition. Morgan Kaufmann, druhé vydáńı, 2011, ISBN
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2014.

[20] Robertson, B.: Facing the future. Computer Graphics World, prosinec
2013.
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Př́ıloha A
Seznam použitých zkratek

FPS Frame per second (sńımek za sekundu)

CG Computer Generated (vytvářené poč́ıtačem)

3D Three-Dimensional (trojrozměrný)

MoCap Motion Capture (sńımáńı pohybu)

HMC Head mounted camera system (kamerový systém ve tvaru helmy)

LED Light-emitting diode (luminiscenčńı dioda)

HD Hight Definition (vysoké rozlǐseńı)

KC:D Kingdom Come: Deliverance
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Př́ıloha B
Seznam použitých pojmů

Motion capture Sńımáńı pohybu

Cara Logger Záznamńık, který ukládá synchronizované sńımky až ze čtyř
kamer Cara a umožňuje streamovat živé náhledy kamer prostřednictv́ım
bezdrátového připojeńı.

Cara Light Kit Světelná soustava

Marker Značky, zaznamenatelné systémem sńımáńı pohyby

Blob Pojem pro jednobarevné body na sńımku obličeje herce, jsou detekovány
CarouPost

Armature Skeletová animace

Rig Ovládaćı prvky použ́ıvané pro deformaci 3D objektu

Shape key Funkce v blenderu, která ukládá stavy 3d modelu s následuj́ıćı
možnost́ı mı́cháńı z jednoho do druhého.
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Př́ıloha C
Obsah p̌riloženého DVD

Task...........................................zadańı bakalářské práce
Cara Documentation ...................... adresář s dokumentaćı Cara
Photo MoCap.........................adresář s foto při sńımańı MoCap
Materials .......... adresář s materiály použitými při modelovańı hlavy
Comp ref........adresář s obrázky - porovnáńı renderu s video referenćı
Render1.mp4 ................................. výsledný render animace
Render2.mp4 ............ porovnańı výsledného renderu s video referenćı
blender.....................................adresář s blender soubory

MoCapAnimation.blend.....................zdrojový blender soubor
blendcache MoCapAnimation.blend ........ cache pro animace vlasu

C3D....................................................moCap soubor
Text ....................................................... text práce

Latex ....................... zdrojová forma práce ve formátu LATEX
Thesis.pdf............................. text práce ve formátu PDF
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